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WDSc 4.0!

iSeries AD, IBM Toronto

WebSphere Development Studio for iSeries
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WDSc: RPG/CBL Tools

iSeries AD, IBM Toronto

» RPG and COBOL Tools
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Remote Systems Explorer

iSeries AD, IBM Toronto

1. Remote Systems Explorer

» PDM-like drill-down or filtered access to:
v iSeries libraries, objects, members, records, fields
v iSeries Jobs
v iSeries IFS Folders and Files
v Linux (including iSeries LPAR) Folders and Files
v Unix and Windows Folders and Files
v Local Folders and Files

2.15eries Projects

» Project-based, team-sharable, development

cinorerren " TBM @server. For the next seneration of e-business.



Remote Systems Explorer

iSeries AD, IBM Toronto

e A perspective with many views

» Remote Systems
v the primary "tree" view for exploring

» Commands
v the view for running and logging commands

» Properties
v the view for showing information about selected object(s)

» |Series Error List
v the view for showing errors returned by compilers

> many more Views...

cinorerren " TBM @server. For the next seneration of e-business.



Remote Systems Explorer -

iISeries AD, IBM Toronto:

RSECORNECHIONS

v/ What is a "connection"?
e Information identifying a remote system
e Given an arbitrary name
e Contains environment info such as lib list
e Used in many WDSc tools
» RSE, iSeries Projects, Java Tools, Web Tools,
W ebFacing

v/ RSE manages connections
e Create connections here (using wizard)
e Change, rename, copy, delete them here
e Expand them to work with resources here

oot IBM @server. For the next seneration of e-business.



Remote Systems Explorer

iSeries AD, IBM Toronto

New Connection

: Remote System Connection
- ¥ Remote Systems Explorer - Development Studio |

File Edit Perspective Project Window Help
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- ¥ Remote Systems Explorer - Development Studio Client
File Edit Perspective Project ‘window Help

e - 3%
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#-% New Connection... Welcome to WebSphere Development Studio Client 4.0
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Remote Systems Explorer

» Connections expand to

e 'subsystems”
v Named grouping of functionality

» Subsystems for i1Series:

ISeries Objects
v For working with Libraries, Objects and Members

5 3 o iSeries Commands
7 & e o / v For pre-defining and running QSYS command

sets

f“\o iSeries Jobs
P v For working with jobs

e IFS Files

 ———— ~Forworking with Integrated File,System files "
nererreente o TBM @servén'_ T the et generg £On 0 e-business.




Remote Systems Explorer

iSeries AD, IBM Toronto

1Series Commands Pro nerties

» Library list

» Current library || -
» Initial command|| Libray st
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1ISeries Objects SubSystem

iSeries AD, IBM Toronto

» 1Series Objects SubSystem
e [or drill-down or filtered accessto QSY S

- ¥ Remote Systems Explorer - Development Studio Client M[=] E3
File Edit Perspective Project wWindow Help
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1ISeries Objects SubSystem

iSeries AD, IBM Toronto

»"Library list" 1s only pre-defined fllter

- ¥ Remote Systems Explorer - Development Studio Client
Eile Edit Perspective F'r-:uject Window Help
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1ISeries Objects SubSystem

iSeries AD, IBM Toronto

» Expanding a library lists all objects

- ¥ Remote Systems Explorer - Development Studio Client

e
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1Series Objects SubSystem

iSeries AD, IBM Toronto

> Expanding a src file lists all members

- ¥ Remote Systems Explorer - Development Studio Client
File Edit Perspective Project indow Help

> - > %] 9
EE Remaote Systems =H\= -.5.15‘?3' - X
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1Series Objects SubSystem L

iISeries AD, IBM Toronto:

Fatmchextermal CODE editor;

d 7 LPEx Editor
BersTe /7 CODE Editor

Src\Vember

Compile (Mo Prompk) #

Properties
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Editing N
> L pex ("JLpex") bullt-in IDE editor

- ¥ Remote Systems Explorer - Development Studio Client 1O x|
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@ ORPGSACfilepfsc -
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E Properties =] 5 E'g. v X IR Calculation . ' 0 e i ‘“J
Froperty | W alue -
Mame . GETDATA Contral  Indicatar peration and
M umnber of children 0 lervel MOl Factor 1 extender Factor 2 Resu
Source COULTHAR/QORPGLES -
ot K | = | [entry |F'LIST = | |
Subtype SRC I CLOND1F actoril+++++++2pcodeE)+F actor 2+++++++Fesult++—++++++lLen++D *
Tent tewt for getdata 4| | - o
Tune PPGIF i -
| | LI—I Commands | Outline | T asks | iSeries Job Lu:ungu:uuru:e F'ru:umpter] | BUIIt In prompter
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LPEX Editor Actions

PopURImMERUWItAIN

iSeries AD, IBM Toronto

CREX EQITO)

Cut . .
Cony S CliplhEardiaclens

Find zelection
Select ine

Select character
Select rectangle
Dezelect

Copy zelected text
[Wer ettt selected fept
Move zelected text

| SclechibnactionsE

Delete selected tegt

Filter selection
Exclude selection

o _ meludeyexclideaciions

&dd

Sawve

PRSNG| # HELLOW2 RPGLE

Show D ate Area

I
Fow 7 Column & Feplace 1 change.
ShOW dates ..... BLONOLF actor l++++++0pcod
- ’ 000100 01,1113 FCUSTOMLI  IF E
in prefIX QO0200 01/11/13 DCustnod 5
ooo300 01,1113 D+
area Q00400 01,1113 O CETREUC E D%
Q00500 011113 O return =
Qo0a00 011113 D e e e e e
000700 02/03 /2 2 G VALY
Ooorol 02406730
QO0R00 02,03 /22 C CALL
ooo80l 01,1113 C
oooo0d 01,1113 C parm
Q01000 011113 C partm
Q01100 011113 C partm
001200 01,/11,/13 c Eval
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LPEX Editor Actions

EQit Menuwhen Lpex

iSeries AD, IBM Toronto

editer hasifecus

- ¥ Remote Systems Explorer - Development Studio Client

Eilz § Edic fPerspective  Project  \Window  Help
= 2 undo Ctrl+z ¢ | = m»|A
Y | % Bedo Gty x | 7 HELLOWZ2 RPGLE
Column 30 Replace 1 change.
I % 03'? Ut e+ L, CLONO1F actorl++—++—+0pcofle (E)+Extended-facton
: Q00100 01,11./13 FCUSTOMLS IF E K Disk
@ Lopy Ctri+C 000200 01,11/13 DCustnod = Tike (L
T | [ Paste Chrl+y 000300 01,/11/13 Do*
- 000400 01,/11,/13 O CETREUC E D5 extrnams
Eﬂ':l)" 000500 01,1113 O return s 20
¢ Delete Delete 000600 01,1113 T
000700 02/03/22 iz E'wal custrnii="001010
Select All Chrl+8 000701 02/06./30
_ QO0E00 020322 [ CALL '"GETDATA'
% BindfReplace...  Ctr4F DO0R01 0111713 c
000900 01,/11,/13 C parm lu
|| ¥ search. Chrl+H 001000 01,/11/13 c parm d
Findiandfilter Find hext Shift+74 B 1200 gﬁﬂﬁg : bval INLR = *ON |
Find Previous Chrl+L 5 = -
aCtl O nS Find Cther Find Selection
Filter Selection Find Start of Seleckion/Block Alt+Page up
Exclude Selection Find End of Selection/Block  Alt+Page down LI
Show Al Zhr] 4 Find Last Change Zkrl+]
Fimd Cuick: kM ark AlE+
Add Bookmark i 2 @ ;
Find Mark. .. 4 ox
SEIEchion Select ‘ .
Selected J -
dCLENS Desslect At L Comparesiiweimempersvisually
Mark k -
= My Lirwis * | | Commands i -
T I _ompare g J I J I =
001S Keystroke Recorder k mmands] iSeries Job Log) Outling | T asks

RECOIASIKEYSITOKESHTOITENENUVENASKS

oIingForRPGandCOBOLPit]%M @sewer' FOI‘ the




LPEX vs CODE Editor

iSeries AD, IBM Toronto

» Lpex Editor
e Re-write of CODE Editor for Eclipse

» What it has today:

e All base support from CODE Editor, such as.

» Alt+L/C/M/D/U/S/J to select/copy/move/delete/unselect/split/join
» Select streams, lines, blocks and rectangles (Edit menu)
» Command-line for directly entering editor commands

» Keystroke recording for repetitive tasks

» Compare utility

» Rich search, find and replace

» Bookmarks and quick marks

» Ctrl+L to locate a line

» Line-number and datestamp maintenance + prefix area

» File->Get File to import a file

» Filter Selection to only show lines containing selected text
» Printing

20
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LPEX vs CODE Editor

iSeries AD, IBM Toronto

> Lpex iSeries Support

» Color highlighting for RPG, COBOL, CL, DDS

» Maintenance of 12-byte line number and datestamp
» F4 Prompting

» SEU prefix area commands (eg |, Il, D, DD)

» RPG/DDS ruler

& » What Is yet to come:

e REXX macros (Java macros are supported)
e Outline View support

e 1 context senditive help
» but all reference manuals are available in Help perspective

e Syntax checking and Program Verify

e Miscellaneous CODE tools and extensions
» RPG SmartGuides, Field Reference tool, Navigator Tool, Zoom...

21
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iISeries AD, IBM Toronto:

1Series Objects SubSystem L

Compreusingtpicallcommand

Compretsingyourpre-aelined
Command

EEEEEE

ompile (Mo Prompt) CRTRPGEMOD, .,

Properties other. ..

Wiork With Commands. ..

22
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1ISeries Objects SubSystem

iSeries AD, IBM Toronto

CompiieWity Prompt

E,%E:reate Bound RPG Program (CRTBNDRPG)
File Edit Wiew Help

Frogram: Hame
Library: |COULTHAR Narme

Source file: LDRPGLESRC Mame, ARPGLESRC
Library: COLULTHAR Marme

source member: |CALLF'Gru1 Marne

Generation severity level: |1 0 0-20

Text 'description”; I”SHCMEIHW Character value...

Default activation group: ¥ *EQ L A

Advanced Farameters

Caompiler optiohs: | j Al

*EVEMTF Fermaye

e g

fl e dan

Advancedl cancel | Help |‘?|
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1ISeries Objects SubSystem

iSeries AD, IBM Toronto

= TRV Comprie

Prafile: I coulthar Select
Mermber type: I RPGLE

MEMBERPE

— Compile Mames '[O SCOpe C d
SRCEETGE A R - commandio O m m an S
Chanae |
Delete \
Duplicate |
Moye Down | Compile Hame

Create a new compile name. -

CRTBMDRPG PGM[ELAM] SRCFILE[RLAEF] SRCMBR[EM) EIF'TIEIN[“E"»:"ENTF]A

j Compile narme: |h-1_|,| Compile Carmmand

oK I Cancel || Command string: IMYEDMF‘ISHEFILE[&LH&F]SHEMEH[&M]MDDULE[&LH&M]EIFvII

Command string:

_I List... I Erarmpt... I |
Cipen Wikh g
¥ Show in menu of promptable compile names
i Rename ¥ Show in menu of non-pramptable compile names
o fitheselclieckhoxes ot Selected|
&5 Move [[FNESEICITECKOXESNOLSEIECIE| Enter compile
% Delete VOUIMUSEUSE OLIER: 1O)SEIECL

command

Compile CRTEMNDRPG. .. | command
CRTRPGMCD. ..
MY COMPILE COMMAND. ..

String

Compile (Mo Prompk) k

Properties

Cther...

Finizh I Cancel |
or the next oeneration of e-business. “
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1ISeries Objects SubSystem

iSeries AD, IBM Toronto

Zpen YWwith 3

@ Fename
Copy
e Move

o Delete

Other,..

ompile

Compile (Mo Prompt) #

Properties

CRTEMDRPG...
CRTRPGEMOL, .
M COMPILE COMMAND. .

- ¥ Select Compile Command |

Wiork With Commands. ..

Prafile: I coLlthar j

I kember wpe: |RPGLE

Compile name: I

CRTEBNDRPG
CRTRPGMOD
by COMPILE COMBMAND

Selectecommandio

SElECIMEMOERIVPELG)SEE
g ;
availahlelcemmanasior

MY COMP SRCFILE[&LAEF] SRCMEBR[EM] MODULE [ELARM) EIF'TII:IN[“E"»:"ENTF]A

[

Command string:

ok Cancel

|
| ]
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Compiling

> Complle Action...

emote Systems Explorer - Development Studio Client

iSeries AD, IBM Toronto

File Edit Perspective Project Window Help
= - &, | X | ¢|a6 | mE»|A
iz Ul Remate Systems B g w x # GETDATARPGLE X ]ﬁHELLDWE.HF’GLE
— . Fow 2 Column 49 kEeplace
’% | El i]"!- EDULTH'&"H LI ..... C'H ame ETDsFrom——+To,/ L+10C . Keywagd s-HH—HHHHH
| = [ i i i led] WEIUATA POMIE Q00100 FCUSTOMLI  IF E K D1sk —~
i Q00200 DCustnoi 5 Tike( 1 =
Complle errors REHFFO30: The name or 1ndical CUSTHD 15 not detined.
QD300 D*
OO0 00 O CSTRUC E D5 extrname (customl 3 icu:
rm— ‘ 000500 d fieldz 10 1
SEETRAEY Shown 1f ISerIeS ] 000600 D return 5 20
' 000700 5 W .
@k Rename =([0)f L|St VleW 000800 c entry plist ElEREROrS
o |E| CATACTL T, - Q00200 C parm Cus .
&l sopy - EVFEVENT “fle.pfdta  — - ; parm et by seventy
o Move QDDSSHE-xf'|E-Ff sc 001200 c _ eval eturn=+hlank
® Delete ~El QRPGLESRC.*file. pf-src 001300 C CUstnoT chain ustoml3
______ . CALLPGHM. rpgle ':":'I:I.4D':' C it nso I
Compile s TS SeGETDATA pgle !
Compile (Mo Prampt) » = ELLOW?Z. rpgle
CRTRPGMOD..., v | .
RC *file. pf-src - D A f
Properties 0)0]0
Cther,.. i ] -
Work With Commands. .. = }:»‘} E D Meszage Severity 0
Property I \alue B RMN59308 Compilation stopped. Severity 40 erra.. &0 2\ero IRPGLE. ..
Mame GETDATA B RNFA120  Estermal descriptions for file CUSTO... 40 [ARPGLE. ..
Number of children | 0 B RMF3523 Extemnal descrption for data structure... 40 4 COULTHAR/QRPGELE. .
Saurce COULTHARAQRPGLES .i RMF7030 IThe name of indicator CUS TN is not defirfd .m COULTHAR/URPGLE. .
Status ] 4 Ol RMWF?030  The name or indicator CUSTHOl iz .. 30 2 COULTHAR/QRPGLE. ..
Subtype SRC —4 |0 BMF7E03  Expreszion cnntalns an operand that a0 15 COULTHARAORPGLE..
Text tewt for getdata "l e = - - -- - “"'-"'I- Tmm _LI_I
Tune RPGF _|v
4| | k Commandsz | Outling | Tasks | iSeries Jab Log 5 ource Frompter liSeries Error List]




Actions on QSYS Objects

iSeries AD, IBM Toronto

> Pre-defined right-click actions

e Common actions

» Rename, Delete, Copy, Move, Properties
» Rename checks for name unigueness as you type!

e Library actions
» Create Source Physical File
» Show In table (Basic or Extra)

e Program actions

» Run (normal, batch, interactive)
» Debug
» Update

e Module actions

» Create Program, Service Program
» Update Program, Service Program

e Data and Source Physical File actions

| » Show-in-table-(Members-or-Fields)—
°"“9F°fRPGa”"C°B°LPi%T\/l @server. lor the next generation of e-business.
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Actions on QSYS Objects

iSeries AD, IBM Toronto

> Pre-defined right-click actions

e Display and Printer File actions
» Show In Table (fields)

e Member actions
» Open with->Lpex Editor, CODE Editor, CODE Designer
» Compile (with and without prompt)
v Can specify what compile command to execute per member type

v Compilers errors displayed in iSeries Error List view
v Double click on error to position editor at offending line

e Job actions
» End (Immediate or Controlled)
» Hold
» Release
» Display Job Log
» Properties

28
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Table Views

iSeries AD, IBM Toronto

B Librar COULTHAR table view 69 x
I ame Type Aittribute T et Statuz - .
FlGETDATA PGM RPGLE TapleNiews

HELLOW “PGM RPGLE :
: : > COIUMNERVIEWS
£ CALLPGM MODULE  APGLE Objects:
£ HELLOW MODULE  RPGLE > Soriakiefy coltmn

@ PHILMSGS
IF‘ o L Ll L

MSGF | Basic

69 X
M are Type Attribute Status | Last modified Created | Size |
. GETDATA *Pla RPGLE Ok, October 4, 2000 8:5312 AM EDT October 4, 2000 2:653:12AM EDT 118734

HELLOW *Piam RPGLE OF. October 4, 2000 25313 AM EDT October 4, 2000 26213 AM EDT 58304
9] CALLPGM *WODULE RPGLE OF. HNovember 3, 2000 9:50:37 &M EST  Movember 9, 2000 3:50:37 A EST 90112
I;%HELLDW *sODLULE RPGLE Ok, October 4, 2000 8:5213 AM EDT ]
PHILMSGS *MSGEF OF. March 22, 20001 8:59:52 AM EST -
| CARDE *FILE FF-DTA ak. October 4, 2000 31321 AM EDT ObJeCtS
CUSTOMERD | =FILE PF-DTA ak. March 23, 20001 8:03:43 AW EST . EXtra
& CUSTOMLIO | “FILE LF Ok, March 23, 2000 8:09:44 AWM EST
E] DATADICTO  *FILE FF-OTA DATA ... OFK March 23, 20001 8:03:44 AM EST
aeries T able Yiew [Extra)

Fl'i.. File COULTHAR/QDDSSRC rmember table view E{ﬁﬁ b
M ame Type Abtribute T et | Status | DATADICTO field table wiew
[E):ABCDEF DSPF SRC ok

CUSTOMER PF SAC Ok,
CUSTOMLS LF SAC Vembers R
M5 TUFF DSPF SAC Ok,

SIMPLEDSPF DSFF SRC 1] 8
TESTTYPES PF sRC 1] 8

2cord Tyvpe Text
CT Character 1 Active Record Code
CT Character 40 Addrezs
CT Character 40 Cuztomer Address Line 1
CT Customer Address Line 2
CT Cugtormer Address Line 3
CT Cuztorner Addreszs Line 4
CT Eharn: Ef Cuztorner Addresz Line &
CT Packed Decimal 9.2 Apnont
Outline [iSenes Jab... |Tazks |Source Pra... |Commands |Properties | iSeres Tab... |iSeres Tab... JCT Facked Decimal 3.2 Cuztomer Amount Due
77777*'7- CT Packed Decimal e Amount Received -

e 1BM @server. For the next generation oI e-DUSINESS.




User Defined Actions S

iSeries AD, IBM Toronto

RSEUSEFACHIONS

» User-Defined Actions (like PDM!)

e Right-click on 1Series Objects
» Work With File Types
v Create named types to scope actions against
v Eg. "RPG" might be RPG + RPGLE + SQLRPGLE

» Work With Actions
v Create, delete or change user-defined actions
v Scope them by File Type

> Tip: you can import CPO Actions!

30
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File Types for User Actions

E_E RBemaote E;_|r|:5:t|3r|'|:5: =& -gh' v W ISerIeS AD, IBM TOI’OﬂtO

- Mew Connection...

-3 Local

EI% by iSeries
SR i cries Objects
#-gk iSeries Commanc
gl iSeries Jobs

(=00 ]
Qpen in Mew Perspective

- Ty IFS Files Work \With User Ackions. .,
-&ﬁ}? Refresh
Change Password
Relzase Interackive Jok 2 I " NETN... | Name: IFH:'G
Yerify Conmectian [+ Object
Connect - Member Types: |RPG* RPT*SOLRPG SOLRPGLE
Lisconmeck - ALL
C|ear Password Cache -
Properties - CBL
CL
- DD5 =
‘ - Dspr e VpEs
‘ -~ MENU > Named colleclion|o)
Mew File Type - PEM .
— " SCalar OrgENENc
Uzer-defined File Types
A Defineg a new file type clazsification 1:ypes
.
» R, dloliranname
+®  Types |SOLRPGF SOLCEL® One ormore Slmple

O OENENC WPES

Cancel

i J Finish
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Defining User Actions

iSeries AD, IBM Toronto

E.E Femote Systems =& @;ﬁ' v X ‘

- New Connection...
I B Local

[ews

% My iSeries Cpen in New Perspective

k

ERE i

l R ISE[IES Enmmands

work With

! +-giy iSeries Jobs G5 Refresh
- Ty IFS Files

UserActions
> [DEfineienjeciand

Eile Tvpes...

memneracions

Change Password
Release Interackive Jab
Yerify Conneckion
Conneck

Disconmect

Clear Password Cache

Properties

> Qi existing|actions

¥ Work With User Actions

New User Action

User Action

Define a new uzer-defined achion

Action: I.-“-‘-.-:II:I to library list

Comment; I

Commarid: |leDLIBLE 5N

|_ Eefresh after
v Show action

Finizh I Cancel |

|- Mew... : :
| - Object | Action:  Add to library fist
&0 ;i:i?mber Caomrment; I .
" it fibrany list Command: I.&D DLIBLE &M se P DM-I[ke
e sufstitution

[ Refresh after

v Show action Varlables

— Types

W anables

&M Selected object name, not gualified j

e 1BM @server. For the next generation of e-business.
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Using User Actions

iSeries AD, IBM Toronto

N MNew Connection... -
B Local

= % My iSeries

=2 I%ED iSernies Objects
_'ﬁb our libraries. .
5P Yourabjects.. B3 Add Library List Entry (ADDLIBLE)
-5 our mernbers. . ; .

:%:b Library lit File Edit Yiew Help

: 1 . .
Elij:'D :d}t' LI:IbIIIrEIrII_ETsH ﬂFI Likrany: m— Marme

"[F"’ e Hew » Library list position:
B COLIL THARE - P e -
=, CARDEMD &5 Refresh ist position:

- My Objects

Feference library:

éiac:b My bdembers df Rename ; /.
[+]- iSenes Commands pmands
-3 Senes.nhs Copy

# Delete

= Properties B = E
Froperty | Walue Show in table »
M ame COULTHARZ User Actions #

Mumber of child... 0 ]
! zﬂ:ﬂ:rn chi Bevs Propetties s j ||:;,:,,.nn.|an,:|S j I
Chabn Mk al

4 I | 4 Enmmands] iSeries Job Log  Outline | T asks

qoox
My iSerie=: ADDLIBLE LIB{COULTHARZ?) ;I
Library COULTHARY? added to library list.
Cause . . . .o If the ADDLIBLE command was

TR o

- IiSeries Commarn "’l I

by iSeres
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RSE Filters

iSeries AD, IBM Toronto

RSEEIters

> Expand a subsystem to see "filters"
o LikeWRKXXXPDM generic namefiltersbut

» Are named and saved

e Thereare some predefined

» Such as Library List to see *LIBL libraries in iSeries Objects
» Such as popular commands in iSeries Commands

e Tocreateyour own, right click on subsystem
obj ect
» Or select "Your XXXX..."

e Each filter can contain multiplefilter strings
» So you can list all libraries that start with A and B

34
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RSEQSYSFilters
» Library filters ’

» Specify simple, generic or special library names
v Library name can be simple, generic or special

» Object filters

» Specify simple / generic object names, lib-qualified
v Library name can be simple, generic or special
v Object name can be simple or generic

» Specify simple / generic object types and attributes
v Can specify one or more type:attribute pairs (OR operation)

» Member filters

» Specify simple / generic mbr names, lib/file-qual®fd

» Specify simple / generic member types
v Can specify one or more member types (OR operation)

ou can import CPO Filters!

90l rRPGandCOBOLPartl.prz TI 35




RSE Filters

> Library Filters namedland

¥ Remote Systems Explorer - Development Studio Client erSISted

File Edit Perspective Project Window Help

All fllters are

Mew Library Filter

Library Filter

BEEE| X%
"_LT.E Remote Systemns

- Mew Connection...
#-B Local

=48y My iSeries

EIE'D iSenes Objects

Create a new iSeries librany filter

Farert filter pool; Default Filker P

' i i oo
Filter narne: by Libraries

|
|
— Filtker Strings

EEFFIEE

}:b our objects. ..

G CouL:
}:b Tour members... CAR* 2 B
-2 Library list Change... |
-k Beries Commands| A —
. elete |
EJ"% :i;";ls"l':'bs Library Filter String i
- e Create a new library filkening zting wl
I ————.. Il
: . £ tove Up
SPECISIMPIE;
= [
ibrany: (G5 JJ Eriowze.. | (W
SPECial Orgeneric —II \2)Eiltera|contain one.of
Test :
loreyAeme I more filterstings: 7 x
! Properties ; > Resilisae OR™d _
Property | value Einizh Cancel
MName “our I I—I =
Murnber of children 1 Eirish Lancel |
Mumber of filker st 1 __ =
Farent filter Mot applicable .
Farent filter pool Drefault Filter Pool — —
Type iS eries prampting ibrary filke: IMy izeries j I'SE”ES Enmmandsj I j Fi
4 | | » I:l:ummanl:lsJ Outling | Tasks iSeres Job Log) Source Prompler
yolingF{ rRPGATIES BEtBRRg Jhyary fiter 36




RSE Filters
> Expanding Library Filters

- ¥ Remote Systems Explorer - Development Studio Client
File Edit Perspective Project ‘window Help

S I
=§£§.?v x

+- % New Connection... -
+-B Local
= % My iSenies
= Ef'_, iSenies Objects
_'ﬁ?' o libraries..
w| Filter created successiully.
+ :%:b our objects...

iSeries AD, IBM Toronto

+ :%:f-* “four members...
+ }:? Library list

i My Libranes
[ COLLTHAR
+-[ff, COULTHARZ
+-[ff, COULTHARS
+- i, CARDEMD

=

15 enes Lommands
+ % igenes Jobs
l |

Froperty | W alue

SlLerCreatea Winen
eA,)d.nded, ISTSTAllNIRS
fletienlif) g NILETSSUING(S)

CIILETIE

~

L‘J :_-"E Carnrmards

iz Properties = ;i:w B + x

.

M ame

Source
Status
Sublype
Tt

TIII‘II=II

COULTHAR

Mumber of childrien 0

5YS
0K i

PROD

Philz library |M}' ISenes ﬂ |i5&ries Enmmandsﬂ |

< 1R

Commands | Outling | T azks | iSenes Job Log ) Source Prompher



RSE Filters

iSeries AD, IBM Toronto

> Object Filters

;¥ Remote Systems Explorer - Development Studio Cliefiyey, Object Filter }

File Edit Perspective Project window Help

Object Filter *"
T | | =H\= %9 | & Create a new iSeres object filker *I:‘I 2
| !

IE Remate : S %-_:?3‘ v X
- New Connection...

H-B Local
El% My iSenies Expand
Elﬁh iSenes Objects - e
:".f:p “Yaur libraries. . I CARDEMO~ OBJTYPE[®) -E 1
3 o objects.. 8 Nvew —
:%:b Your members. . Change. ..

-2 Library list Object Filter String
iﬁb My Libraries

SPECSIMpIE,
SPECIAIIeOENENC
lIrenname

Farent filter pool: Default Filter Poal

Filter narne: IM_'.-' Objects

Filker Strings

FEFFIRE

Create a new object filtering ztring

I SpECIfy Slmple or Optlona"y ................................... |
SUSElY |
M are ‘Your ohjects. . obJeCt type [uplizate |
MNurmber of u:_hilu:lren 0 ; Mave Lp |
Numher_n:lf filter st... 1 _ and attﬂbute —
Farent filter Mot applicable Miowe Down |
Farent filter pool Default Filter Poal
Type iSenies prompting obje — |
ol | B

._.: X il’i; g phject filer

v (/out vyuld, 1UL LLIU 1ICAL 5’511‘51 diiull

38
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RSE Filters

iSeries AD, IBM Toronto

Object Filter String

Create a new object filtering ztring

-
N

Librany: |F'HILDEMEI

jj B[Dwse...l

Object: Ii

Type and attributes to subset by

“PGM:RPGLE
“FILE:*SRC

All\ehjecis mesting
Ny Gl e yeesalil
fillersianedisied

jj Brgwse...l
y/

Change...

Delete

Duplicate

tove Up

fd e [Mawm

Finizh I

Cancel

> Object Filters: Filtering by type+attr

- ¥ Add DObject Type And Attribute |
Object bpe: Object attribute;
[FILE ERIEE =4
Types to chooze from Attributes to chooze from
*BHDDIR —
*ChD
*OTAARA
*OTAL
*EOTD C
*FILE CBL
*|0BD CBLLE
=JOBL CLE
*MODULE CLLE
“MSGF CLP
*M5GE0 CMD (.
*0TO CFPLE
*PLM COMF
*PHLGRF DFU
*FPROMYL — |DFUEXEC
Select fromilistsior Cacsl

PRI SINpPIE 0]
Genernciypeand
alliiuie

cinorerren " TBM @server. For the next generation of e-business.
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RSE Filters

» Expanding Object Filters

- ¥ Remote Systems Explorer - Development Studio Client

iSeries AD, IBM Toronto

File Edit Perspective Project ‘window Help
¥ - X% ¥
H EE Remote Syztems =ﬂ_,‘; @.1»?3* - X
% = %hﬁlyiﬁeries ﬂ
3 - gy iSeries Objects
+ :%:b our libraries...
T.:,' = :"f:f-*' our objects...
;ﬁ_ w| Filter created succeszsiully.
+ }:’ﬁ our members...
—*| . -
-5 Librany list A . ] ‘
£ g My Lo ST CreEalea WIEn
—|-gp+ Mp Objects . A .
BECUSTEAL “pam pglc R e\(pglnrlerl “3[3 ;|” Ob BCIS
] DISPLAYCAR "pom.mpgle <—. L A Y -
=] REMTCAR.*parn.rpale ' r“- iellele r‘g :‘i- 0 (:‘)
+ CARCLASSES. *file.pf-dta \rifarin
2. CARCOLORS *fle. pi-dta erit=flet
+1-[5] CARDE."file. pf-dta Ad
Jd | 1171 Tf: Commands ox
= Properties BB v x =
Froperty | W alue -
Marmne CUSTBAL
Mumber of children 0
Source CARDEMO f
Statusz 0k J
Subt RPGLE
T:thpe |h-1y 15eres ﬂ |iSeries Enmmandsﬂ | ﬂ i
Turne “P5 hd il
1 | * Commands | Outling | Tazks |iSenez Job Log) Source Prompher
RPAnAMOROL Part] o



RSE Filters

iSeries AD, IBM Toronto

File Edit Perspective Project window

» Member Filters

¥ Remote Systems Explorer - Development Studio Clies

Help

New Member Flter

Member Filter

Create a new iSeres member filker

| | X%

!_l_TE Femote Sy

shems

#-_ N New Connection...
B Local

EI'% My iSeries

EIED iSenies Objects
E- _'ﬁ'ﬁ' our libraries. .
E _'ﬁb four objects...
_'ﬁb our members.. 1

EE—H.
i [-= | ibrany fist

peC|fy SImpIe i
SPECIal I gENENC: i

Ilbra name

FEFFIRE

SPECISIMPIEIo!

Member Filter String

Create a new member filkering string

Farent filker pool: Drefault Filker Poal

Filker narme:

> W

*II _ Charae...
d Delete

Library:
™ ! | SRC

ber: [TEST®
[ ce members
kember bppes to zubset by

|EDULTHﬁH

[Duplizate

jj B_ru:uwse...l

jj BTQWSE...l Mave g

i e [mwwm

TR [ |

jJ Ernﬂse...l N
EEETER  Slihsethyidata or Solice mbrs

enelicfilemamne /
|

e ‘
]

e |
pec:|fy SIMPIEION =
genericimemoe.« &
flelpplel Mt applicab
Farert fer poo Default Filer
Type iS5 efies promg
ol
i5eq Figmber filker

VL L/ ow

Optenally

SURSEL Y
MEMBEN iype

e 3

Change...

[elete

[ruplizate

Hiove Up

fd e [awn

= Prompter

Test

41
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RSE Filters N
> Member Filters: filtering by mbr type

Member Filter String *"
Create a new member filtering sting
I

- ¥ Add Member Type |

Librany:  [COULTHAR jJ MI Member type: | 'I J
File: il jJ Ml Types to choose from

b ember: IE jJ ET'I'HSE---l “BLAMK j

C
¥ Source members [T Data members CEL

CELLE

Member bppes to subszet by CLD
/ CLE
add. CLLE
LChange. .. I EH:';
; CPP
Alllmembersimesting gt | crrie
- lanylofitheltype filters ko : rrr =
] ; tMowve Lp
aieilisted oo | K Cancel |
' | _|

Selechiremilist eI iype

INISIMPIE GIf GENENC
Finizh I Cancel | member type
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RSE Filters

» Expanding Member Filters

- ¥ Remote Systems Explorer - Development Studio Client M[=] E3
File Edit Perspective Project ‘Window Help
i\? i J_.\: ag | ¢
ITrE Remaote Systems =.R_.\= '5-,',5(}3' v X
% by S eries ﬂ
- %f'_, iSeriez Objects
+ _'ﬁf-*' Your libraries. .
+ :"f:f-*' Your objects...

= }:EP “faur rembers...
& Filter created successiully.

¥ 2% Library l =HEE GIAALE

5 b My Liires =ILET; greelice I. Wnen

-z My Objects ~

- M_I,I Meml:uers "‘/(,.)"rld‘:‘ I

S GETDATH Py frletee i)
E] HELLOWZ rpgle . .
=) MYPROGRAM.ipg Jfl[e”a

1Iaenes Lommands

+ % iSeres Jobs f
il | | s :_-'ﬂg Cormmarnds

@s\. v
Property | W alue -
MName CALLPGHM
Murmber of children 0
Source COULTHAR/QRPGLE JJ
Status (] J
Subtype SRC

Tt bt 1 |M_I,I iSenes j |i5&ries Commandsz ﬂ | ﬂ

Tire RERIF
1 k Commands | Outling | T azks | iSenes Job Log ) Source Prompher

iSeries AD, IBM Toronto

r | x

i‘li

1= Properties =
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Filter Pools S

iSeries AD, IBM Toronto

RSEEIterPools

> Eventually, you'll have too many filters
e Timetoturn on " Show Filter Pools' via

preferences or pulldown in RSE title bar
» Expanding subsystems will then first show filter pools

e Filtersaregrouped into named pools
» By default they are added to the single default filter pool
named Default Filter Pool

® Y ou can create your own filter pools
» Then add filters to it
» Expand a filter pool to see just the filters in it

e Filterspoolsgroup filters
» Group by project, release, connection, task, etc etc

44
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Filter Pools

iSeries AD, IBM Toronto

> Filter pools are shared
e Subsystem don't "contain” filters!

Connection 1 _
— . Default Filter Pool
‘ Seres Uslecls SubSvgtem h‘l references Filter 1 | Filter 2 || Filter 3

| | / .
' Filter Pool 1
Connection 2 Filter 1 | Filter2 | Filter 3
‘ iSeries Objects SubSvstem/n_l/ Filter Pool 2
CC -

| 'I‘ Filter 1 | Filter 2 || Filter 3

|
SP15-EclipseToolingForRPGandCOBOLPartl.prz

ror—erver—rOI the next generation of e-business.
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Filter Pools

iSeries AD, IBM Toronto

> \Why share filter pools?

1. Filters shared across connections
» Filter created in connection A can be re-used In
connection B
v By placing the filter in a filter pool shared by both connections

2. Flters private per connection
» Create a unique filter pool per connection if sharing not
desired

3. Filters both shared and private per connection

» Some filter pools can be private, some shared
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Filter Pools

iSeries AD, IBM Toronto

IE Femote Spstems s @}5? v X | |
B Mew Connection... Meww Conmection,
[+ Local
DE W o Select Active Profiles k
= g". iSenies Objects Rename P.r':'ﬂle g
l _'ﬁb Your libraries... Copy Profile g
. _-ﬁb Your objects... Delete Profile *
I S “Your members. . " : =
. :%:{} L||:|rar_|r| ||St NEW PrDFIlEI“ EE FiEfrI'II:ItEf E;_IrI:E:r.Efrl'I!E: =& '&).{&' w
l i}D My Libraries gualify Conmection Marmes - Mew Connectiar...
l Efb My Objects l B Local
= My Members bl leen il ies) =- &l My iSeries e
EIR= fSEf@ Commandsz Default User ID 3 gy iSenes Objects F||ter pOOIS Shown
2R iSeries Jobs Show Filker Poals =I-_g® Default Filer Pocl
M- Oy IFS Files Shaw Filtor Strings - _-ﬁb Your libraries... | UnGerSiSYsems
By My Other iSeries l _'ﬁb “four objects. .
Team L4 I _-ﬁb 'our members. .. ——————————————————]
- R -5 Librany lt [Eilier: s SHOWM UACE
: I if=€> My Libraries

I EI‘& My Objects
& [r{“? My Members
g i5eres Commands
gy iSeriesJobs

- Ty IFS Files

EEI--% My Other iSenies

SHoWEIerPoeoISk
CAN0ES RSE ree-View.

[0/ displayilier poes
URBErEalnISuesysiens
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Filter Pools

~ Right-clicksior r—r——
i SUSYSIEMI PO System Fiter Pool o
B N New Connectior... 1 Define a news pool For filkers (ST
Local *"
-l My iSeries
g f
: = Y T My Pool
~_g® Default Filker Pool ble i Filker Pool... 2 e namel s e
:%:& ‘Your libraries.. & 2elect Filter Poals... Filter Pool Reference # Frafile Iu:-:uulthar j
I}:P rour objects... Cpen in Mew Perspective
[+ :{::P our members i
:%:b Librany list Mfork Wih '
H | . .
ih& by lerarles Q}% Refresh
H-m by Objects
ﬁ'#" My Members izhange Password
-gi ?S BlEs Commarids Release Interactive Job
-l 15 ENES Jobs Werify Connection
- Ty IFS Files o
#-f My Other iSeries Discornect X Q@? v x
Zlear Password Cache - -
: Mew Connection...
Propetties &8 Local
EI% My iSeries
I__—_Iﬁn iSenes Objects Finizh Cancel
= Default Fier Pacl
-3 Your libraries. .
1 : 1] il ;
SHOW EIErPopIS 3 Your cbiects.
[+ our members..
o P . .
EABIES USEFOENNED -5 Library fit
. . iﬁb by Libraries
filteIrpoo!S and filter: g My Objects S\ FilierPea
: ; H-g My Me
ool o)is) ] e cates afilterpool ans
H-mfk iSeres Commands
SUNSYSIEMIPERUPITMERU g Sorins Job AUUS A TElerence to
- Ty IFS Files A calarta A
o 0 0
EEI--% My Other iSenies
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oIingForRPGandCOBOLPit]%P ] Properties

Filter Pool References

EE Remote Syztems

EE Remote Sypstems

éﬁ{ﬁ-’v ®

- Mew Connection...
B Local

=By My iSeries
=-gh iSeries Objects
=-—be Default Fiter Poal

:%:b our objects. ..

[+

}:& Librany list
Iiﬁb by Libraries
1_§|'=:€> by Objects
ﬁ=:€> My Members
----- :i My Pool

H-mfk iSeres Commands
-y iSeriesJobs
- Ty IFS Files
I':'I--% My Other iSenies
EI];D iSeries Objects
. [@_pe Default Fiter Paol
#-gk iSeries Commands
ﬁ. iSenies Jobs

- [

H - . -
-5 our libranies. ..

=+
-5 Your mennbers..

:l_,ﬁ_'@]?v x

Toronto

F- Mew Connectiar...
-8 Local

EI% by iSenes

EI]ED iSenes Objects
=-Be Dafault Fiker Pool
}:b Your libraries...
:%:b Your objects. .

H-mfk iSerez Command
- iSeries Jobs
- Ty IFS Files
EI--% by Other iSeries
I__—_Iﬁm iSenes Objects
[+ Default Fileg
iy
H-gk iSenes Commands
- iSeries Jobs

[ T IFS Files

aleISHoWaY.
AdnGelerences

OINEm

- Ty IFS Files B Select Filker Pools. .
Dpen in Mew Perspective
Wtork With
0 -@?3‘- Refresh
a RERLIR Chiange Passward

Release Interactive Job
YWerify Connection
Canneck

Discommeck

Clear Password Cache

EE Filter Poal. ..

Filker Pool Reference #

coulthar  k

Team

k

business.
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Filter Pool References

E | Remate Syztems

&Eﬁﬁv *

- New Connection...

B Local

Ela My iSeriesz

El-r‘:b iSenes Objects

=-he Default Filter Pool
:%:f-*' Your libraries. ..
}:? our objects...
}:’ﬁ Your members...
:%:b Library list
iﬁ? My Libraries
i"%& ky Objects
&3 My Members

----- :i by Piool

+-@#k iSeres Commands

-l iSernies Jobs

- Ty IFS Files

I':'I--i by Other iSenes

IEl-'::'D iSenes Objects

. [#-TBe Default Filteg

: - :" by Pool

gk iSeries Commands

ﬂ. iSeres Jobs

- Ty IFS Files

AllreIerences ;e poes) Witin
SUSYSIEMS;, are upeaied ierelect
2Ny CAN0ES 1o Al erpeo):

> eWiiliers

> deletedfiliers

> renamediiliers
> fieordered iiers

U\ Library Filter. ..

iSeries AD, IBM Toronto

E | Remaote Systems

%Eﬁﬁv 4

F-_ N New Connection...
#-B Local
Eli My Senes
EI.'-‘:'D iSenes Objects
=-—8e Default Fiker Pool
:%:b o libraries...
:%:P* our objects..
:"f:b our mermbers. ..
:%:b Library list
iﬁb Mu Libraries
i"%? My Objects
1_]'=:'|> by bembers
= e My Poal

i'=:€> Contents of COULTHAR lib

Cpen in Mew Perspective

E{@ Refresh }:f}'\ Member Filker. ..

@ Rename
Copy
v Move

BP Remove Reference

# Delete ‘

aF Maove Up
& Move Bown

Properties 3

+-@f iSeries Commands
g iSeries Jobs

®- Ty IFS Files

=y My Other iSeries

EIL:ID iSeres Objects

. [@-_Be Default Filter Pool
' EI:E* My ool

: 28 Conterts of COULTHAR lib
#-gk iSeries Commands
ﬂ. iSenes Jobs

®- Ty IFS Files

S —
REferences ofilier ololo)fs

cCantheremoyed

oot IBM @server. For the next seneration of e-business.
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Filter Actions

iSeries AD, IBM Toronto

> Popup menu actions for filters:
e Update parent filter pool that contains the filter
e Reflected in al subsystems that reference pool

-¥ Remote Systems Explorer - Development Studio Client =]
File Edit Perspective Project indow Help

hd R ._ Ellieraciions

| — Editfilier
| Depnamefilier

- New Connection...
B Local

L——_I% My iSenies

EI]ED ienies Objects

Dpen in Mew Perspective

-L;}(}?' Refresh

&-—8e Default Filker Pool
E---:ﬁi My Pool
E=8=% Contents of COLULTHAR i
g Source files in CARDEMD
- RPG members in CARDE
H-@dk iSeries Commands
g iSeries Jobs
- Ty IFS Files
=-Ey My Other iSeries
El]ﬁm iSenes Objects
-8 Default Fiter Poal ,
=-The My Paol Show in table C

K G

O Rename
Copy e}
o Move

# Delete

4 Mowe Lp

L Move Down

g Contents of COULTHAR lib 1
1‘3'.%5 Saurce files in CARDEMO F‘rperties | k Delete fllter
- T RPG members in CARDEM = FIUpEiiE B E v X \ :
% gk iSeris Commands Property [Value Reordertiliers
4 gl iSeries Jobs Name Contents of COULTHAR lib
EE'"'IED IF3 Files Number of children 0
Murmber of filter strings 1
Parent filter Mat applicable

oplingForRPGandCOBOLPartl.prz 51
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Profiles

iSeries AD, IBM Toronto

RSEPrOfes

> The RSE Is designed for team sharing
e Of connections
e of filter pools
e Of user-defined actions

> Team sharing Is enabled via profiles
e All connections, filter pools, user actionsare
scoped per profile

» Each profile is a folder within the RSE project
» All data stored within subfolders

e \When RSE project isteam-synched

» All out-going changes sent to team repository

» All in-coming changes received from team repository
o IBM @server. For the next generation of e-business.
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Profiles and Teams

iSeries AD, IBM Toronto

> All persistent data in the RSE Is stored in an

Eclipse project "under the covers”

e Project Is named RemoteSystemsConnections
»\isible in Eclipse-supplied Navigator view
e This project isteam-sharable by the common Eclipse

team support for projects
» Using the Navigator view
» Or using Team cascading menu of the RSE pulldown

=,H\,= é.'ﬁ‘a" X |
=H\= Mew Connec ior... e Conmection,
F-B Local _ _
EI% My i5 eries Select Active Profiles 3
= Eﬁ] iSeries Objec Rename Profile 3
Bl _pe D Fault FIt Pool Copy Profile b
=8 } My Pool Delete Praofile 3
- 1}& C '.:.r.r.er.r. s .:.r COULTHAS .
. EI':{’ S ou Di‘-.FEDEh Mew Profile. ..
- 1]‘5’ HPG e l'l'lt' h CARD|  Qualify Connection Mames SynChronlze Wlth
H-@% Seres Commands
e iSerieanbs Refresh All (FS)
EEl---'ﬁ'D IFS Fi!es . Defaulk User ID 3
=l My Other iSeries v Show Filter Pols
EluéinzléerE&Fb:fE;f Pool Show Filker Strings Identlfy team
- 3 oo T o -
: |ungFarRPGﬁe@baouﬁmmcuuuHm — _ ; IEPOSILONY
- EI'*’ Sou I:.-'f‘-.F:DEh iSeries roperties ;




Profiles and Teams

»

»

iSeries AD, IBM Toronto

- ¥ Remote Systems Explorer - Development Studio Client

File Edit Perspective Project indow Help

S - %]

#-{zge CarRiental
-1 DefaulEAR

fﬂ- b yProject

ﬁp by Project

ﬁ b pS econdwebProject
- MyWeI:uF"rmeu:t
= ﬁ RemateSystemnsConner

|wggﬁm

chomns;

=] 1= En:nnnectin:nns‘
--1’55 My i5enies

F-= My Other iSeres

[+-{= Filters

[+-{= Uzerbctions

----- [¥] compileM amM\

----- [¥] prafile.zmi

+-{= tarr
[H-[= Team
~{z= TupeFilts
-1z FemaoteSpstemn?] Mwg
- |z FentbCar
]ﬁ Semvers

-z Test

- Ja TestPDE Project

| O ey R oy O e O e |

Navigaterview

RSE Project

= “coulthar profile folder

(a IfconnEctions ceineaiior roflle coulinan
\ alllfilter pools defined for roflle colltnar

| a IlUser actions definedfor pr Il user actions defineaiior pr oTIeIcoulthar

\ allcomnie Commandsiior profilercoulthan

‘| Froperties

s 5 By v OX

farr EI‘OfI|e folder

LI Ay 770 0 kg

team nnofile folder

Jd |

ections
nections

k

Remaote System

lNavigatDr]

Tazks ) Source Pr... | Outline | Commards lF'rn:npertiesJ iSeries Jo...

dcoBBEPataSyetemsConnections

Nness.
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Profiles and Teams

iSeries AD, IBM Toronto

Team Repository
RSE project = snen

» Team profile

> connections
> filter pools

» user actions

» Developerl profile
> connections
> filter pools
> USer actions

» Developer2 profile

> connections
> filter pools
> user actions

Developerl IDE

RSE project
» Team profile

» Developerl profile
» connections
» filter pools
» USer actions

» Developer2 profile

Developer?2 IDE
RSE project

» Team profile

» Developerl profile

» Developer2 profile
» COnnections
» filter pools

» USer actions

cnorerreni " TBM @server. For the next generation of e-business.
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Active Profiles

iSeries AD, IBM Toronto

» After ateam-synch on the RSE project, a
developer's IDE will have all the profiles for
the whole team

e However, they only see connections, filter pools and
user defined actions for their "active' profiles

e By default, the "team" and the user's private profile are

the only active profiles
» S0 developer only sees all connections, filter pools and user actions
that are in the team and developer-unique profiles

e |t Iseasy to make addition profiles active
» Use the menu items in the RSE title bar pulldown menu

56
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iSeries AD, IBM Toronto

EE Remate

v x|

F-_ N New Connection...

-8 Local
L——_I% My iSeries
=8 g iSenies Objects

[+ ke Default Filter Pool

EIZE" by Pool

Mew Connection,..

Select Active Praofiles

Rename Profile
Copy Profile
Delete Profile

v v v ha

v Tean
v coulthar
Farr

@i Contents of COULTHAF
E% Source files in CARD
#-f RPG members in CARD

Mew Profile. ..

Qualify Connection Mames

- :'l' TeamPool

Refresh All (F5)

H-mhk iSeries Commands
- iSeries Jobs

M- Ty IFS Files

E--% My Other 1Senes

Defaulk User 1D
Show Filker Pools
Show Filker Skrings

EI]ED iSeries Objects
[+ T8 Default Filer Pocl

Team

EI}* by Pool
g Contents of COULTHAR

iSeries

EE Remate Systems

- New Connection...
F-B TeamLocal

-

coulthar tu iS enes

% coulthar by Other (5 enes

Profileractions

SEelect this tershew.

CONNECHIBNS
gualiiied By profile

NAme

cinorerren " TBM @server. For the next seneration of e-business.
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Profiles and Teams

iSeries AD, IBM Toronto

Team Repository

Developerl IDE
RSE project

» Team profile

> connections
> filter pools
» user actions

» Developerl profile

» connections
> filter pools
> user actions

» Developer2 profile

> connections
> filter pools
> user actions

RSE project = smen

» Team profile

> DEVEIoper profie FINGi|ieR offelil <ol
» connections
Developerd

» filter pools
» Developer2 profile

Developer?2 IDE
RSE project
» Developerl profile

» DeveloperZ protile
» connections
» filter pools

Active'profiles for
Developer 2

oIingForRPGandCOBOLPiBM @Sewer, F{]I‘ the ne}{t genera tign Of e_business_ 58



Why Profiles?

iSeries AD, IBM Toronto

1. Team-shared connections and filter pools

> S0 everyone on the team sees common connections for with common library

list, environment settings and filter pools
v For common development work. Eg: define profiles such as "team", "

team"”, "projectl team", "release 1", "emergency fix", etc,etc
v Ask each team member to make these profiles active

2. Devel oper-unique connections and filter pools

» S0 developers can have connections with unique library list, evironment

settings and filter pools

v For developer-unique work via their unique profiles
v Each such private profile only made active by one developer

3. Team-shared and developer-unique

» Each developers "sees" connections and filter pools from both shared and
private profiles: whatever is "active"

4. Roaming devel oper
»On PC 1. Developer synchronizes with team repository
v Sends all connections, filter pools, actions to repository
> On PC 2: Developer synchronizes RSE with team repository
v Gets all connections, filter pools, actions from repository
v Makeshisprofile “active* .~~~
e TBM @server. For the next generation of e-business. =
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Active Profiles

iSeries AD, IBM Toronto

» \When creating connections and filter
pools you must specify the active profile to
contain the new connection or profile

New Connection | New Filter Pool |
Remote System Connection System Filter Pool *"
D efine connection infarmation :g: Define a new poal for filkers (I
=i
Poal name I
Profil coulthar j
Team \
farr
< Back | Mest » | Einizh Cancel | | Finizh I Cancel |

60
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B-HE S| X% ¢

E.E Remote Systems

- New Connection...

- B Team.local
E| % coulthar. by iSenes
= ]ﬁ:"n |5&r|es Objects

e Default Ffer Pool

-5.1@}'3' Refresh

IEIII Rename

+f Move

o Delete

Active Profiles

Select the active profile to copy into

FI|E Edit Perspective Project  Windo
— ¥ Copy [ | E—

Y- HE & | Xy ¢

EE Remate Syztems

4+ Mave g
L Maove Down

Discommect Al

Properties

- B Team.Local
E| % coulthar My iSenes
: EI Efl] iSenies Objects
I 3’* Default Filker Pool

=
=]
I% #-_ New Connection...
5]
iry)
% El }W My Pioal

Mesw

-5.5‘}'?-* Refresh

O Rename

I EI‘:’ Contents of COULT
! EI‘{} Source files in CAR

iSeries AD, IBM Toronto

» Connections and
filter pools can be
copied or moved to
other profiles

¥ Remote Systems Explorer - Development Studio Client
File Edit Perspective Project Window | ¥C

] LCancel |

cinerereeenc " TBM @server. For the next generation of e-business.
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Work With Filter Pools

iSeries AD, IBM Toronto

» For one-stop shopping for working with
filter pools, select Work With->Filter Pools
from subsystem popup menu

»You must be in "Show filter nools" mode

- ¥ Work With Filter Pools |

Wk with filker poaols

Mew

oIingForRPGandCOBOLPT}%M @SGWﬁ' L . - _-_Mﬁ-bllSiIlﬁSS. 62




Remote Systems Explorer
» Underlying Model of RSE ’

Profiles| T
—= | Filter Pools s
__| contain | »|Filters

Dre)fllas contain I | Filter Strihqs
Enaple contain -

Lean
SUPPOKLE:

= Connections

e ; contain 1 B Subsystems
ehliective contain I ) . §
Filter Pool:

groupIng
References

reference;

contain

> : :
~ontain User Defined Actions

63
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1ISeries Projects e

iSeries AD, IBM Toronto

e A special project type
» For holding source destined to be compiled on iSeries

e A dedicated perspective

» For working with all, and only, iSeries projects

Jawva Type Hierarchy

Eu-ﬁ. Plug-in Developrent

B2 Profiling

% Remote Systems Explorer [default]
Resource

% Scripts

EB Server
m_IT:h:mn j

k. Cancel |

oo [BV @server. For the next generation of e-business. .



1Series Projects

iSeries AD, IBM Toronto

> I1Series Project Wizard
e For creating 1Series projects

»\What Is an iSeries project?

» Typical Eclipse project
v Contains folders and files, can be shared by a team
v Can have its own tools and perspectives

» But also
v Holds copies of some source members from an iSeries library
v Those copies are "pushed" up occassionally and the project
re-puilt

65
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1ISeries Projects | =i

Project
Wizans

- ¥ Remote Systems Explorer - Development Studio Client
File Edit Perspective Project ‘Window  Help

» ﬁr Project. ..

Clase Chrl+FE4
Clase &l Chrl+Shift+Fe

Save Ctrl+5
E SEve fs,.,
¥ Save Al (i [ e

Select NG
& Print k| +E Create a new iSeries project j&

£y Impoart. ..
Ly Export... - BV3 L | S eries Project
- Data ﬁ] iSeries Source Phypsical File
1 TestPDEProject/plugin. xml -] ava @ iSenes Member

2 MyProject/MYFILE/HELLOWORLD. rpg - Plug-in Development
- Bemote File Transfer

Exit - Server

- Simple

- wieh

- Web Services
- wiebFacing
wbd L

[+ iSenies

Use Flle'>NeW [+~ Examples
[erlaunch

ISErnes) Plioject
Wizard

< Back et > Eimizh | Cancel

o)




1ISeries Projects | =i

Project
Neow — | Wizard

i5enesz Project

Create a new i5ernies project that maps to an iSeries library. 'IE

CHEBSE
connection

Praisct name: IM}' Froject iSeriez Project Properties
- Specify the iSeres project properties.
V¥ Usge default location

Lacation: IE S DS CNWS S D work zpacesty Project Browze. |

frem RSE st
|
onnection; IMyiSeries j Mew. .. |

Specify the name and location of the iSeriez project being created. An iSenes
project allows for local development, while performing builds on a remote iSenies
host machine.

Azzociated librany: IM‘T’LlE| Browse... |

Specify the connection and libran name that you wish to azsociate with this
iSeries project. The connection allaws for remate access to the (Series host
machine. Code changes made locally are puzhed to the zpecified remote libram.
That libramny iz alzo uzed far performing builds on the remote host,

GIVeNeur:
ProJECHe
Name
|dentiiy Asseciated
ISRz thIS IS theitarget

N lioraryAoIRpUSshesiand
Eirizh | Cancel | bUlIdS

< Back

Build Properties Cancel

Specify the build cormatnd.

Build command: [CALL MYLIB/MYELDPGM identify

Enter the buld command bo be izzued on the remote host that will boild this 1Senes
project.

commeandito
callfierBund

Aeilgs rbusiness.
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REES

1Series Projects | .o

PEliSpective
» Dedicated Perspective for 1S Projects

CrealelSenes Createrspurce Createrspurce
I2IGJECT

- ¥ iSeries Pro,~ vs - Devel ment Studir _lient
File Edit PerspeRy

4

- ¥ Select Perspective

iSenes Mavigator =+ X

' |BRData |
% Debug
| Help

dinenes Projects
n-.EIJava
Java Type Hierarchy
Eu-ﬁ. Flug-in Development
7 Profiling
% Femote Spstermns Explorer [default)
Feszource —
T2 Scripts U Remote Spsterns R 69w x || E Propetties B = o+ x

EHSEWE[ |Ser|es PI’OjeCt =H\= Mew Conmection... Property | value
M Taam ;I #-B Local

navigatOI‘: expand B8 My iSeries
k. Cancel | prOjeCt 0)\/0)f1¢

Withilocal'seurnce

=-1= My Project

o) =olro)f

ECEEEEY I

REMBLEISYSIEmSs

VIeWHor
CONVENIENGE

iSeries Navigatar] Mavig: 4 ¥ Remote Systemns | Tazks

|
norerrenc*TBM (@server. For the next seneration of e-business.
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iserieS PrOjeCtS iSeries File %1“-'

Wizard

» 1Series File Wizard

e For creating filesin your 1Series project

i5enes Source Physical File NEW FI Ie i5eries Source Physical File Parameters E

Create a new iSeries source physical file. leard Specify additional parameters.

Enter ar select the falder: CCsID: oD
IM.'r' Froject Record length: j

Theze attributes are used when the *FILE iz created in the azzociated libran of

SPECIy attuies that are used

the iSenes project.

roiect ﬂ

l H-Ta M_I,IWEI:F'rmeu:t o !

#1128 PhiDemo Select J WhenniensHinally createdin
=

-1 PhillavaDemo ; asseeiatedira
-l RemoteSystemsCornections PrOJeCt
#-1z% FemateSystemsTempFiles

[Tl A

Bl Folder name: IEJFIF'GLESFIE

Select an iSenez project and enter the name of the new source physical file
being created. The zource physical file will map o a folder in the selected
iSeres project.

Source File=1a folderinyour project
> UniiN/eU=RUshHYeURCHANTES: _
> Then d CRTSRCPF IS done L Caneel 1]
: 69




0)el]
Wizard

iISeries Projects e

> 1Series Member Wizard
e For creating mbrsin your 1Series project

i5enes Member

Create a new 15eriez member.

Enter ar select the folder:
My Project/QRPGLESRC

& =
#-1a# DefaultEAR

=12 My Project
T g9 NEWFILE Select thelparent :|
.~ BDDSSRC iolder
. [z ORPGLESRC
=l

ﬁ Myt ebProject
o T P e o

Name thelmemoers

bember name: IM‘T’F‘FEDGFE.-‘E-.M.F%F'GLE Rane; t ype

Select an iSeriez gource physical file, and enter the name of the new member
file being created. The member will map to a file in the zelected iSeries zource
phuzical file,

Viemloer =iafilenmyeuriclder
> UntiyoeU-RPushFyeurChanges:
> ThenanABDPEMIs dore Einih Cancel_|

cinorerren " TBM @server. For the next seneration of e-business.
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1Series Projects

iSeries AD, IBM Toronto

» What about existing members?

e Use Add to Project action to copy them

» Right click on project, select "Show Remote Objects"
» Drill down to source file, right click, select "Add to Project"
» Drill down to members, right click, select "Add to Project”

e Filesadded become folderslocally
e Membersadded are copied to that folder

e Developer workson local copy

» Edits file

» Pushes changes using "Push" action

» Does a build using "Build" action

» Shares with team using "Synchronize" action

e Full power of Eclipse at disposal

» Team support

» Marker/bookmark support
___» Editor registraction_support
e TBM @server. For the next generation of e-business.
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- ¥ iSeries Projects - Development Studio Client

Project "Bleedthrough"

File Edit Perspective Project Window Help
= - N RERE YR
= @8 w x || [E] NEWMER X
% : =T
=-[% NEWFILE
HB MEWMER Open Perspective
Ew] =-[% QDDSSAC Import. ..
= [ ABCDEF.dapf ——
3| s
Bl @ - = CUSTOMLA -
o= 1 = MYSTUFF.dspf S0P
’—‘ ----- B SIMPLEDSPF. dspf i
i J = TESTTYPES.pf etz
=-[% ORPGLESAC Delete
""" g F'”:'QIE Close Project
— PIE Refresh

(= HELLOW?Z.pgle

Push Selected
Push Changes

Subrnit Build
Team E Froperties o] }:{‘? E - X
Compare Wikh Property | Yy alue
Replace With — editable brue
. ’ lazt modified 515402 17:47 A
o=z harme CALLPGM. rpgle
ERE T nath /My Project/IRPGLE SRC/CALLPGM.
gize 1]
iSeries Navigatur] Mavigator | Bookmarks Hemate Systems] T asks 1 I | b |

ISeries Project Perspective
"""" 1blV C)SETVEL, or the nex genera On ol e-pusiness.
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- ¥ iSeries Projects - Development Studio Client
File Edit Perspective Project ‘Window Help

1ISeries Projects

N DR E mhB| XS] ¢

%8 iSeries Mavigator
-1z My Project
=-[% NEWFILE

- [ MEWMER

EIE’ ADDSSAC [Local/Remote]

@’ ABCDEF.dzpf [Local/Remate]

|§ CUSTOMER.pf [Local/Remote]
@’ CUSTOMLIIF [Local/Remate)]

|§ MY'STUFF.dspf [Local/Remote]
@’ SIMPLEDSPF.dspf [Local/Remote)
|§ TESTTYPES.pf [Local/Remate]
EIE:? [RPGLESRC [Local/Remate]
CALLPGM.rpgle [Local/Fermate]
%’ GETDATA rpgle [Local/Femate)]
|§ HELLOWZ rpale [Local/Remate)
@ CUSTOMERD *file.pf-dta [Femate]
E DATADICT Q. *file. pf-dta [Remote]
[~ @ LRPGSRLC *file. pf-zrc [Remaote]

E TESTTYPES. *file.pf-dta [Femote)
@ TESTTYPESZ *file.pf-dta [FRemate]
E TESTTYPES 3. *file.pf-dta [Remote)
@ TESTTYPES4. *file.pf-dta [FRemate]
E TESTTYPESE. *file.pf-dta [Remaote)
E TESTTYPESE. *file.pf-dta [Femate)
E TESTTYPESY *file.pf-dta [Femate)
g CALLPGM. *module.rpgle [Remate]
ﬁ CUSTOMLI0 *filef [Remote)

» [ocal files and members
Use Push popup menu action
to copy from project to library
Use Build to build project
USe ieam->Sync to copy
to/from team repository

> [EIM0LE 01]ECts; filesiand mirs
Use Add 1o/ Prejectito copy
from library to project

(Rempoie)=> 1|

> Gl existsiinassociatedirarny

(Local/Remote)=> i

e existsilocallyand i associated [0

i (local/Remoeie) ==

1
> conilicteiween Iocal andiremore

| : b

otherwise=> L4
> only EXISIS IocaIIy
E l =€> ‘T"-:nur meml:uers

=

Fin GETDATA.*pam.ipgle (Remote]

Femote Systemsj Tazks

NISEHES ProjECHNaVIGaLoNR

(1w CE+. KE}thr"dS-l—l—l—l—l—l—l—l—l—l—l—l—l—l—l—l—l—l—l—H

custnii="0010100"
'"GETDATA'

custhnoi
cstruc
return
FIMLE = *0M
| i
BB v x
| W alue
frue
B/A02 1227 P
CALLPGM.rpgle
My Project/ORPGLESRC/CALLPGM.ip
1222

Local Member: Ay Project/URPGLESRC/CALLPGM. ipgle

e 1BM @server. For the next generation of e-business.




Mew
Open Perspective

Studio Client
dow  Help

File Import,..

= show Remaote Objects |=1_'h_ ™ | :?| I | HEE > | A
i Copy i &% w x || | NEWMEBR II &7 CALLPGM.ipgle X |
Mioe - koW 1 o TLmn L ReEplace _
% Rename — B ... FFilename+IPEASFRTen+LE ] en+AIDewv ce+. Keywords
% OO0 100
Delete 000200 DCustno 5 ke (CUSTNG
ﬁ EthE] |:":":|3|:":| D*
| Close Project VRemat Qo000 O CSTRUC E D= exctrame {custom] 3 scustomll)
Al cal/Remate] 000500 D return 5 20
B ocal/Remote] Qo0 e00 D1 e

Qo000 iZ EvAL custnii="0010100"
OO0 E00 C ALl '"GETDATA'
Push Changes [ 000=01 c :
_ . B TRLREE A C parm custhno
Submit Build ] Q01000 C parm cstruc
001100 C parm return
001200 C ewal *IWLE = *0OHN

Compare With »
i b
Hplags Wi Local/Remote]

Propetties ta [Remate|
— a [Femote]

[~ @ I]FEF"GSFH:“IHIE |:|f zic [Femaote)
----- E TESTTYPES. *file.pf-dta [Femote] I
_____ % EgH:iEg;“E::Z E: 3:: EEZQE::} A A3 Remote Spstems % &5 v  x NG Properties B = E - x
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1Series Projects

iSeries AD, IBM Toronto

Prod Lib
‘ o

» Using projects

ISt library|list library list

Dev?2 Lib Dev3 Lib
Team
Repository
<
a Devl IDEI Dev2 IDEI Dev3 IDEI
Il
< team team team

sync sync sync
e Projectstypically hold small delta

» EQg: Files necessary to implement new feature

e Each developer can have uniqueassd lib

- » EQg: For private builds
oIingForRPGandCOBOﬁa@ge team SyﬂCh tO ple up Colleaguels WOI’k SO far 75




1Series Projects

iSeries AD, IBM Toronto

» Stay tuned...

e |Series Projects are new, and their

functionality is still immature

» They are offered initially to gather feedback so
they can subsequently be optimized to best match
your development patterns

e Thesupport for 1Series project will

Iterate quickly in coming releases
» Including much better integration support for
ISeries change management vendors such as
Aldon, MKS and SoftLanding.
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More Information?

iSeries AD, IBM Toronto

» Information Sources

e Www.lbm.com/softwar ¢/ad/wds400
» Portal for WDSc

e Www.eclipse.org
» Eclipse and information about eclipse

e Wwww.ignite400.org

» Introduction to eclipse article

® cServer 1Series magazine, July issue
» 3 articles on WDSc

e Www.Ibm.com/webspher e/developer

» \WebSphere Developer Domain

» Many articles and tutorials on technology and tools,
Including eclipse and WSWB and WebSphere Studio
configurations
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Trademarks & Disclaimers

iSeries AD, IBM Toronto

8 IBM Corporation 1994-2002. All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.
The following terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both:

AS/400 IBM(logo)
AS/400e iSeries

e (logo) business 0S/400
IBM

Lotus, Freelance Graphics, and Word Pro are registered trademarks of Lotus Development Corporation and/or IBM Corporation.
Domino is a trademark of Lotus Development Corporation and/or IBM Corporation.

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product and service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. Actual
environmental costs and performance characteristics may vary by customer.

Information in this presentation concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available
sources and does not constitute an endorsement of such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly available
information, including vendor announcements and vendor worldwide homepages. IBM has not tested these products and cannot confirm the accuracy of performance,
capability, or any other claims related to non-IBM products. Questions on the capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. Contact your local IBM
office or IBM authorized reseller for the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities. Such information is not intended as a definitive statement of a commitment to specific levels of
performance, function or delivery schedules with respect to any future products. Such commitments are only made in IBM product announcements. The information is
presented here to communicate IBM's current investment and development activities as a good faith effort to help with our customers' future planning.

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment. The actual throughput or performance that any user will
experience will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the 1/O configuration, the storage configuration, and the
workload processed. Therefore, no assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes. Changes may be incorporated in production models.
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